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BDMS is an imaging and electronic document management system for clients who use Banner products.
It is designed to meet the imaging and document management requirements of higher education.
BDMS provides integration with the Banner application suite. Specific integration is within each of the
five functional areas — Human Resources, Finance, Student, Financial Aid, and Advancement. BDMS
works as an integrated product with Banner and Documentum Software’s document management

system, ApplicationXtender (AX).

Access to BDMS is controlled by your login to My Portal. You are not required to learn a new id and

password.

Document Organization — Very Important

Student documents will be stored or “indexed” using the student’s CWID (Campus Wide Identification
Number) and a document type. Document types have been pre-defined and will be selected from a list.
A couple of examples are “Other College Transcript”, “High School Transcript” and “Petition”. Each
student can have only one BDMS document for each document type, such as Petition. However the

student’s Petition BDMS document may contain multiple scanned petitions. It is most likely that a
student will have multiple BDMS document types, such as on titled Petitions, one titled Other College
Transcripts, etc. Here is a list of all the document types defined to be used with student data:

Document Input

Document scanning will take place in a central location in
Admissions and Records at each college. All forms to be scanned
will be marked with the student’s CWID prior to scanning.
Documents can be scanned one at a time and then indexed orin a
batch of multiple documents and indexed after the batch is
scanned.

BDMS can also be used to store and attach other types of
documents such as pdf, MS Word documents and jpg images (or
photos). These other documents do not need to be scanned if they
are already in a machine readable format.

Document Viewing
There are two options for viewing documents:
1. Clicking on the Banner Document Management System link
under Banner Applications on the Banner tab.

2. Selecting the BDM view icon from an Internet Native
Banner (INB) form.

ABS40 FORMS

ACADEMIC REMEWALS
ADDYDROPS

ADWANCED PLACEMENTS
ALDIT

CERTIFICATE OF COMPLETIONS
DEs

EDLGOAL EDUCATIONAL GOAL SHEET
ECQPS FILES

ENVALUATIONS

EXCESE UNITS

GRADE CHANGES
GRADUATION APPLICATIONS
HIGH SCHOOL PERMISSION LETTERS
HIGH SCHOOL TRANSCIPTS
IEP

IGETCS/CSU CERTS
INCOMPLETE CONTRACTS
INTERMNATIONAL

LATE ADDS/LATE DROPS

MISC MISCELLANEOUS

MNAME CHAMNGES

COTHER COLLEGE TRAMSCRIPTS
P/MP

FETITIOMNS

ROOC RESIDENCY DOCUMENT
REFEATS

RESIDEMCE RECLASSIFICATIONS
SPECIAL PROJECT FORMS

SEN CHAMNGES

SUBPOEMNAS

SUBSTITUTIONS

TIME CONFLICTS

VETERAMN RECORDS

Pre-defined Student
Document Types
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VIEWING DOCUMENTS
Using Banner Tab Link

From My Portal a user
can go to their Banner
tab and then select
Banner Document
Management System.

The web version of
BDMS will openin a
pop-up window which
can be closed using the
Xin the lower right
corner.

All student documents are stored in B-S-ID —
BANNER STUDENT COMMON which in the
world of BDMS is called an application.
Clicking on the second icon from the left
(under Edit) will take you back to this view.
BDMS referrers to this view as the
Application List. Each folder icon represents a
different application.

Each folder/application/file cabinet under
PROD is called contains different documents
and you must select the correct application to
find the data you are looking for. Starting July
10, 2011, new documents being entered into
BDMS will be stored in the appropriate B-S
folder. Documents brought over from earlier
imaging systems are stored in the appropriate
STARRS-CONV... folder.

Application Name Description

B-S-1ID — BANNER STUDENT COMMON Where all student-related documents entered after the July
10, 2011 Go-Live date, are stored.

B-S-SECT-BANNR CATALOG/COURSE SECTION Where all catalog/course-related documents entered after
the July 10, 2011 Go-Live date, are stored.

STARRS-CONV-INSTRUCTOR-DOCS-REJECT Where instructor related documents that did not convert
cleanly are stored

STARRS-CONV-INSTRUCTOR-RECORDS Where converted instructor related documents are stored

STARRS-CONV-STUDENT-DOCS Where converted student related documents are stored

STARRS-CONV-STUDENT-DOCS-REJECTS Where student related documents that did not convert

cleanly are stored

Important: If your search of one Application Folder doesn’t produce the document you are looking for,
you will need to search the other Application Folders that may contain the document.

ETS — FHDACCD 8/18/2011
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Right Clicking on Application Folder

BDMS is designed for a PC and most functions can be accesses by clicking the right button on your
mouse. Then move the cursor to the function that you want click as you normally do (with the left
button). To right-click on a Mac hold down the Control key and click. The following functions are
available by placing your mouse on the application/folder/file cabinet you want to access and right

clicking:
Options Use
New Query Will bring up the query options for the selected application
New Cross App Query Allows you to query two applications at the same time. (Not
currently supported)
New Document Allows you to save a new document via one of 6 options
Properties Information only

Set As Active Application | For student data the B-S-ID — BANNER STUDENT COMMON
application should be bold to indicate it is the Active
Application. Use this to change or re-set the Active
Application

Reports Not available

Searching for a Document

There are several ways to initiate a search. You can right-click on the Application Folder, click the search
icon (third from left on top tool bar) of select from the View drop-down menu. The search view will
display where you can enter the criteria you wish to search on. Note that each Application Folder
contains different criteria that are searchable. After entering the search value click on submit at the
bottom of the screen to view the results. Below is a screen shot of the B-S-ID — BANNER STUDENT
COMMON Application Folder query screen:
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Query Screen for STARRS-CONV-STUDENT-DOCS:

Query Screen for STARRS-CONV-STUDENT-DOCS-REJECTS:

Note that these documents are indexed by the students social security number, name, and birth date.
At the time of the
conversion there was no
matching CWID.

ETS — FHDACCD 8/18/2011
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From INB Form

To view the BDMS documents associated with a student, you can use a Banner form such as SPAIDEN, to
select the student by name or CWID. Once the student’s name and ID display, you can use either of the
two BDMS button on the top of the form to open a new window or tab with the

The system will display a list of BDMS documents stored for the selected student.

In the example above, there are three document types, Advanced Placements with one page, Academic
Renewals with one page and Miscellaneous with two pages. Click on the document icon to the left of
the listing to display the document image(s).

If a document you expect to see is not displayed, you will need to check the other Application Folders:
1. Click on the Application List icon to display the list of Application folders

2. Right click on the folder which you want to search, move your mouse over
New Query and click to display the list of search criteria.

3. Follow the instruction on page 3 on Searching for a Document.

ETS — FHDACCD 8/18/2011



To view the thumbnail images, use the View
drop-down menu or click on the right most
icon. To include the index in your display,
use the drop-down View menu or click on
the icon to its left

A

Use the Page drop-down menu or Page
Back and Page Forward icons to view the
two pages in this document. Use the
Document drop-down menu or Document
Up and Document Down icons to view the
other documents for this student.
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When View with Index is turned on, the display will look like this:

ETS — FHDACCD
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ApplicationXtender Web Access Icons
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ApplicationXtender Web Access Drop-Down Menus
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SCANNING DOCUMENTS
Getting Started

Scanning will be performed on a PC/Windows system. The user must log into the system with the user
name “BDMS” and the password provided by your supervisor. This will link the PC to BDMS. On the
desktop you will see two short cuts.

e “Document Management” is used to scan a one document at a time and to
index all documents including those scanned as a batch using Image
Capture.

e  “Image Capture” is used only to scan batches of documents and will be
covered under Batch Scanning.

Clicking on the shortcut will take you into ApplicationXtender Document Manager. This program will be
used to scan in documents. On the left, the file (cabinet) titled B-S-ID — Banner Student Common should
be in bold. This is where all student documents will be stored.

Setting up the Scanner

1. Adjust the scanner settings using the drop-down Scan menu.

2. Resolution should be 150 unless the page is especially poor quality
3. Mode should be 256-level grey unless color is absolutely needed

4. Paper Size is almost always Letter (8 1/2" x 11")

ETS — FHDACCD 8/18/2011
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Choose Rotation-Front and Rotation-Back as needed to make sure the scanned pages are
oriented properly. Rule-of-Thumb: the scanned image you see at scanning time is what will
be seen via Banner. Banner users will be able to magnify pages but not necessarily able to
spin pages

Configuration - Driver Configuration is where to adjust Contrast and Brightness

8/18/2011
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De Anza

1. Set up the scanner for flatbed mode

2. Putthe piece of paper onto the flatbed, up against the top left corner
Foothill

1. Make sure the scanner driver in use is the "ISIS - Fujitsu fi-4530C" driver
2. Goto Scan - Configuration - Select Scanner via the menu tree

3. Select the ISIS driver - it's about 1/3 of the way from the top of the list. NOTE: Testing has
found that BDMS works much better with the ISIS driver than with the WIA driver at the
bottom of the list of drivers

4. Source: To scan only one side, choose
ADF Simplex. To scan both sides, use
ADF Duplex

5. Choose Rotation-Front and Rotation-
Back as needed to make sure the
scanned pages are oriented properly.

6. Feed: Leave on Auto as a rule

IMPORTANT CONCEPT: Be aware if you are
scanning a new document or a new page into a
document. Documents are made up of one or more
pages. You must tell the system that you are
scanning a new document. Other wise the
additional pages scanned will be added to the
current document.

Scanning and Indexing One Item at a Time

1. Load the document in the scanner.

2. Click the New Document button (the yellow
folder beneath the “View” menu choice),
choose “Scan”, and click OK >>

OR
Choose Document — New — Scan from
the menu tree

3. The piece of paper will be scanned and will
display on the screen

4. Enter the ID of the student and hit Tab

5. Make sure the Student Name matches the
name on the document

6. Choose the appropriate Document Type from
list.

7. Choose the appropriate Term Code

Click Save at the bottom of the screen.

9. If you get the error message “A document with
the same unique key already exists “, that means that the student already has a BDMS document of
that document type. You must locate that document and add the new pages to it. These
instructions can be found on page x of this guide.

o
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10. At this point you have created a BDMS Document containing one scanned page. To scan the next
Document, repeat steps 1 through 10.

11. If you want to add a page to the current document, select Page Menu - Scan - New. You now have
three options: “Insert Before” (page displayed), “Insert After” (page displayed) or “Append” (add as
last page of document).

Indexing Scanned Documents

To retrieve a BDMS Document for deletion or to add/delete pages

1. Right-click on the appropriate BDMS Application and choose New Query, or right-click on an
existing query and choose Edit Query

2. Enter the query information needed to retrieve the Document you want and then click Search

3. If only one Document is retrieved, it will display on the screen. If multiple Documents are returned,
a list will display. Double-click on the Document in the list

4. To delete this entire Document from BDMS, use the Document — Delete menu item

5. To delete pages from this Document, make active the page you want to delete and choose Page —
Delete from the menu

6. To add pages to this Document, use the Page — New — Scan menu items. Place the new page as
appropriate via Insert Before, Insert After, or Append

7. If you reorder pages within a Document, you will need to create a new version of the Document and
then remove the old version:
7.1. Go to Scan — New Version — Current View to create a new version of the Document.
7.2. Go to Scan — Purge Version to remove the old version of the Document
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Adding Items to an Existing BDMS Document

ApplicationXtender allows you to search for index information from existing documents and append
pages to previously indexed documents. The Attach feature allows you to choose an existing document
from a result set and add a new page to the existing document. To append a new page to an existing
document:

1. From the Document menu, select New and then select an input option from the submenu to
create a new document. AppXtender displays the Index view.

2. Enter data in one or more of the index fields, and then press [F4] to initiate a search for
documents that meet the specified criteria. The AppXtender Result Set appears, listing the
results.

3. Select the index record and click Attach. The new page is added to the existing document that
you selected.

De Anza - To scan multiple pieces of paper as a single BDMS Document into the B-S-ID Application
(cabinet):

1. Set up the scanner for flatbed mode

2. Put the first piece of paper onto the flatbed, up against the top left corner

3. Click the New Document button (the yellow folder beneath the “View” menu choice), choose
“Scan”, and click OK >> OR <<

4. Choose Document — New — Scan from the menu tree

5. The piece of paper will be scanned and will display on the screen

6. Enter the ID of the student and hit Tab

7. Make sure the Student Name matches the name on the document

8. Choose the appropriate Document Type

9. Choose the appropriate Term Code

10. Click Save at the bottom of the screen.

11. Put the next piece of paper of the Document onto the flatbed, up against the top left corner

12. Hit Ctrl-S >> OR << Choose Scan — Scan Page from the menu tree

13. At this point the next page has been added to the Document. To continue adding pages to this
Document, repeat steps 9-10 as needed

Adjusting Scanned Documents’ Quality and Orientation

1. Place the pages into the scanner.
a. For Portrait pages, put Page 1 face down and upside down, with subsequent pages in order
and oriented the same way
b. For Landscape, control rotation via the Scan - Rotation-Front and Rotation-Back settings (see
2e above)
2. Click the New Document button (the yellow folder beneath the "View" menu choice), choose
"Scan", and click OK >> OR << Choose Document - New - Scan from the menu tree
3. The paper(s) will be scanned and the image(s) will display on the screen. Use the page buttons (the
arrows in the boxes two rows beneath the "Annotate" menu item) to cycle through the pages
4. |IF the images are of not sufficient quality, choose Document - Delete to erase the scans, reset the
scanner via the steps in (2) above as needed, and rescan per steps 3 - 5.
IF the images are satisfactory, index the images by entering the ID of the student and hitting Tab
Make sure the Student Name matches the name on the document
Choose the appropriate Document type
Click Save at the bottom of the screen

O Now
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9. At this point you have created a BDMS Document containing the image(s) you scanned. You can

delete individual pages, change page order, etc. via the Page menu items

10. Once you are satisfied with the BDMS Document, close it by clicking the grey "X" just below the Red
"X" at the top right. DO NOT click the Red "X"; this will exit you completely from Document
manager

11. Repeat steps 1-10 for each BDMS Document you want to create.

Scanning Multiple Items at a Time

Foothill - To add pages to an already-existing BDMS Document:

1. Retrieve from BDMS the Document to which you want to add pages by:
a. Right click on the B-S-ID Application at the left of the screen, and choose New Query, or
click on an existing Query and choose Edit Query
Enter the information into the Query screen needed to retrieve the Document you want
If your Query retrieves only one Document, it will automatically open. If your Query
returns more than one Document, a list of Documents will be presented. Double-click
on the Document you want to open.
2. Adjust the scanner as needed for your new pages
3. Choose drop-down menu: Page - New - Scan - Append to add the new pages at the end of the
Document
4. Your pages will be scanned and added automatically to the Document. No Save is needed.
5. You can delete individual pages, change page order, etc. via the Page menu items
6. Once you are satisfied with the BDMS Document, close it by clicking the grey "X" just below the
Red "X" at the top right.
7. DO NOT click the Red "X"; this will exit you completely from Document Manager

To create a batch of scanned pages which can then be indexed as BDMS Documents:

1. Open Image Capture using the shortcut on your desktop. Log into the “Image
Capture” software using your MyPortal ID and password
2. At De Anza, set the scanner to Flatbed via the Scan menu. We cannot depend on
the document feeder working dependably. At Foothill, set the scanner per the

instructions in the Creating a New BDMS Document section.

3. Create a new Batch
e Right-click on the BDMS Application into which Documents will be placed, and choose New

Batch
e C(lick View — Applications to display the list of Applications
e Use alocal naming convention to give unique names to batches, recognizing that multiple
people may be accessing the batch list at any one time

4. De Anza - Place a piece of paper onto the flatbed and hit Ctrl-S to scan it. Foothill — you can set the
feeder to Auto, meaning when you hit Ctrl-S all the papers will scan. Alternately, you can set the
feeder to Single, meaning each time you hit Ctrl-S one sheet will feed & scan per your scanner setup
items.

5. Repeat step 4 as needed to scan your entire set of papers to scan

6. If you scan a page and want to remove it from the batch, hit Ctrl-X OR use Page — Delete from the
menu

7. Once the batch is completely scanned and ready to index, use the File — Close menu item to close
the batch.

8. Exit the Image Capture Software.
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To index a batch of un-indexed batches of scanned documents:

13.

14.

15.

Log into the Document Manager software using your MyPortal ID and password.

Make sure to make active the correct BDMS Application into which the batch’s scans will be
saved as Documents

Choose Utilities — Batch Index (List) to bring up a list of eligible batches ready for indexing.
Select the batch you want to index and then click Index

The first scanned image in the index will display. Click on the New Document icon — the first
icon in the third row of icons, under the File menu. The Index window will open.

Enter the ID of the student and hit Tab

Make sure the Student Name matches the name on the document

Choose the appropriate Document Type

Choose the appropriate Term Code

. Click Save at the bottom of the screen.
. In the dialog box “Would You Like To Add More Indexes”, click No
. At this point you have created a BDMS Document containing one image. If you want to add

additional images to this Document, use the Attach page icon (third row of icons, second icon)
for each additional page.

Once you are finished with this Document and want to create a new Document, repeat steps 5 —
11 as needed.

Once the last image in the batch has been indexed, a dialog box will display asking if you want to
index a new batch. Proceed accordingly.

Note that individual pages can be deleted from a batch via the Page — Delete menu item OR via
the small Red “X” icon next to the New Document & Attach Page icons

Setting Up your screen for scanning

To display thumbnail images of documents in the queue, select from the “Main” Toolbar “User Settings”
, select “Document View” from the menu on the left side, deselect the first option “Show Page
Thumbnails”.

Copying Existing Index Information

ApplicationXtender allows you to search for index information from existing documents and copy the
existing index information to populate the new document’s index. The Copy Index feature allows you to
choose an existing document from a result set and copy the existing index information to the new
document.

To copy index information to a new document:

1.

From the Document menu, select new and then select an input option from the submenu to
create a new document. The Index view displays.

Enter data in one or more of the index fields, and then press the {F4} function key to initiate a
search for documents that meet the specified criteria. A list of results will display.

Select an index record and click Copy Index. The index information from the existing document
that you selected appears in the new document’s Index View.

If needed, make changes to the index information.

Click Save.
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Copying the Previous Index information

If you are adding a series of documents and entering similar index information, such as term, for the
entire series, the Copy Previous Index Info feature may help you to save time and avoid mistakes.

To copy the previous index information:
1. Add the first document in the series. Enter index information and click Save.

2. Add the next document in the series. Select one of the index fields and press {F9}. The index
fields are populated with the same information as the previously indexed document.

If necessary, make changes to the index information.
4. Click Save.

Repeat steps 2-4 for each additional document in the series.
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Toolbar Buttons

Main Toolbar
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Batch Indexing Toolbar Imaging Toolbar Buttons

Scan Toolbar Buttons
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Annotation Toolbar Buttons
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